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Introduction
The London tube map design is well known and has been used for many other purposes beyond 
navigation around London.

Recently, various cycle campaign groups have used the design to show aspects of cycling provision 
within their particular areas of interest. The goal of each map differs with some using the map for 
navigational purposes and others using it to make design future requirements or to make points on
the quality or otherwise of the cycling network.

Cycling UK, as part of their Space for Cycling campaign, have encouraged cycling groups around the
UK to create localised tube maps and have provided guidelines and templates based on the work 
by Bath Cycle Group. http://www.cyclinguk.org/guide/make-tube-map-cycle-network

This guide adopts a different approach to that proposed by Cycling UK with the aim of producing a 
similar output to that created by Cycle Bath i.e. a schematic map showing the current quality of 
the cycling network in Derby. This map is being used to raise awareness of the issues with the 
wider public and to raise the priority of cycling issues within the Council officers and councillors.

One major difference from the Bath style process is that the output consists of 2 maps – one tube 
style map that is used for publicity and a separate online “conventional” map showing the routes 
taken from A to B and, thus, the roads rated for the map colours.

Software used
The following software was used in the creation of the Derby tube map:

• QGIS mapping software. http://www.qgis.org/

• R programming language https://www.r-project.org/

• Rstudio development environment https://www.rstudio.com/

• stplanr transport planning package for R https://cran.r-
project.org/web/packages/stplanr/index.html maintained by Robin Lovelace

• Cyclestreets API (called via stplanr package) https://www.cyclestreets.net/api/ A key needs 

to be requested from the developers in order to use the API.
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The above software was installed on an Ubuntu Linux system https://www.ubuntu.com/

In practice the QGIS environment was created on one Virtualbox virtual Ubuntu instance and the R 
environment was created on a separate virtual instance in order to keep any cross dependencies 
separate. This is probably not necessary and all the software should be installable on a single 
system.

Opencyclemap https://www.opencyclemap.org/ was used as the background display for the maps 
to assist in the moving of stations process.

Desire is to use Open Source software for all development. This is free to use both in the sense of 
“no cost” and also with minimal restrictions on how the software can be shared. 

Other mapping software exists (e.g. ArcGIS) but is often very expensive for licences. Most 
campaign groups are unlikely to have funds to allow them to use commercial software and open 
source software is therefore preferable.

Overall Process
The process consists of a number of steps (some repeated).

1. Define possible stations on a QGIS map.

2. Calculate routes between possible stations using Cyclestreets

3. Define routes between pairs of stations (that will be on tube map).

4. Relocate stations / add new stations / delete stations  based on routes

5. Repeat 2-4 until finalised number and locations of stations and all the routes that are 
required.

6. Rate all routes on 1-5 scale and colour lines to match ratings.

7. Create a new QGIS map that will be basis for tube map.

8. Generate a grid (square) for “snapping” locations to.

9. Starting in centre, move stations to snapped locations.

10. Recalculate routes using R code to match the moved station locations and redraw.

11. Repeat 9-10 until all stations are placed

12. Modify routes to only use 90 degree and 45 degree links.

13. Use Print composer to create output PDF and PNG files.

The final result is 2 separate maps in QGIS – one showing the real locations and links, the other 
showing the tube map. To minimise duplication of effort, as much collection of data should be 
done as possible before creating the “tube” map. After the tube map has been created, any 
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changes (to links, to ratings, etc.) needs to be updated on both maps. However, code can be 
written to check for discrepancies and to move data from one map to the other.

Creating the map
Create a new project in QGIS. Set an appropriate CRS for the project. Think about this at this stage 
as changing it later is a pain. The Derby map uses “WGS 84 EPSG 4326“ which uses latitude and 
longitude degrees as coordinates. With hindsight EPSG 3857 (which uses metres for coordinates) 
might have been a better choice.

Install Openlayers plugin Plugins>Manage and Install plugins

Web>Openlayers plugin>Openstreetmap>Opencyclemap

Add a new vector layer (points) for the stations. Create suitable data fields. The Derby map uses:

• Name – meaningful name that will be displayed on the map

• Place – type of place – e.g. Station, Hospital, Employer,..

• Fixed – used to specify when the station location and all links from the station are finalised 

Use “Add Feature” button to add stations.

The Derby map uses shapefile format – other formats may be selected and may be better for 
future analysis.

Defining the stations
Initial process was to select candidate stations. The goal is to have around 100 for the map to be 
the right mix of intelligibility and usefulness.

The following items were marked on the map:

• Secondary schools (primary schools produces too many stations)

• University major sites and other educational establishments

• Railway Stations

• Major employer sites

• District shopping centres.

• Hospitals

• Bus stations

• City Centre. Initially, various sites were marked in the city centre but it become too 
complicated to accommodate all the sites which were often only yards apart. It was then 
decided to mark the “city centre” as a single “station”.



After the first iteration of calculating the routes between the stations and displaying the results on 
the road network, it becomes clearer where people cycle across the city. Certain locations can be 
moved to a nearby junction on the displayed network whilst still retaining the same name.

There will probably be obvious junctions on the network that haven’t been marked as “stations”. 
These should be added and given a meaningful name based on a nearby landmark, pub, or similar.

Defining the links
Once the first attempt at defining the stations is complete, the routes between the stations can be 
created using the Cyclestreets interface. The output from the Cyclestreets routes is then added to 
the QGIS map to show the actual roads used by the journeys between the stations. 

From this display, obvious routes between adjacent stations can be seen and created.

Create a new vector layer (lines) as a shapefile.

Fields used on the Derby map are:

• Route – name of the route. Often the road name used for most of the link

• Rating – 1 (good) to 5 (bad) rating for the link. The worst part of the link is used for the 

rating. 

• From – name of station at one end of link

• To – name of station at other end of link

• Notes – free format field to add information on reason for rating

• ID – unique number to identify the link

Use add feature to mark the start and end stations for each link. Enter the data needed for the 
route name, rating and ID. The From and To will be added automatically later.

Cyclestreets
To create a set of routes between the provisional stations and to see the roads used by the routes, 
the Cyclestreets programming interface is used. 

This is called from a R program using the stplanr package and the route_cyclestreet function

trip[[trip_counter]] <-

        route_cyclestreet(from = foo2@coords[fr, ],

                          to = foo2@coords[to, ],

                          plan = "balanced")

where foo2 represents all the stations and fr and to are the counters between all the stations. Each
station is routed to every other station. For performance reasons this routing is only done one way 



– i.e. if A is already routed to B then B to A isn’t calculated. This might be a shortcoming for a city 
with a lot of one way routes or gradients that mean that A to B route doesn’t match the B to A 
route.

All the calculated routes are combined and then written out to a shapefile which is then displayed 
on the QGIS map as a layer. 

The Cyclestreets API offers “fastest”, “quietest” and “balanced” options. These are calculated and 
could be shown on the QGIS map but the “fastest” option is used to drive the definition of the links
between stations. 

Whereas initially all stations are routed to all other stations, as the map becomes more defined 
(over a number of iterations) the Fixed field is used to specify when a station and all the links from 
that station have been defined. Setting Fixed=1 means that it is excluded from the “all to all” route 
calculations. Over time all stations become fixed.

To use the Cyclestreets API, you must use a key supplied by the developers. The stplanr package 
suggests storing this key in the .Renviron file:

echo "CYCLESTREET=f3fe3d078ac37777" >> ~/.Renviron

where you substitute your key for the example.

Creating the tube map
Once all the stations and the links between stations have been defined on the real map, the 
creation of the tube map can be started.

Create a new QGIS project and take copies of the routes and stations data from the real map. For 
the Derby map, these were names as tm_routes and tm_stations to distinguish them from the real 
map versions.

Generate a background grid
To allow placement of stations on a regular grid, create a background grid. Processing>Commander
search for Create Grid. Then choose appropriate settings for the parameters which will depend on 
the CRS being used and the size of the area being mapped. For Derby the following are used:

grid type – rectangular

grid extent – use layer of stations

vertical and horizontal spacing – 0.005 degrees

Specify filename to save to. Then add new layer of the grid to the map.

Format the grid as simple lines (double click on layer and select “style”). Once happy with the size 
of the grid then turn off display (unselect orange box next to layer name).



Turn on snapping Settings>Snapping Options. Select just the grid layer and set a value like 30 pixels
to vertex only. This will allow moving of stations and links to align directly on the corners of the 
squares on the grid.

Moving stations
Positioning the stations is where a degree of “art” arises! 

The goal is to position the stations such that their position relative to close by stations is 
approximately correct (e.g. if A is north of B in real life then try and get A above B in the map. 
Some leeway can be allowed – maybe A being diagonally above B is fine. However, avoid B being 
above A).

The distance between stations is generally ignored. 

Best approach I found for positioning the stations was to start in the city centre, try to position 
stations around the city and then concentrate on an obvious east-west and then north-south 
route. Other stations can then be placed relative to the these main east/west and north/south 
alignments.

Whilst the links can be moved at the same time as the stations, it was easier to just move the 
stations and then to run a R program to update the links to match the new positions for the 
stations. 

Adding River
As with the London tube map, a river on the map provides some context. If you add a river then 
ensure that the stations fall on the correct bank to avoid confusion.

The river was created as a new vector layer. The snapping options were modified to allow 
placement of the river vertexes on the segments of the grid. 

Placement of “stations” that are actually river bridges needs some thought. With the snapping 
options, they will generally fall on one side of the river or the other. 

Formatting
In general use map units as the unit for measurement of any size specified in the formatting so that
zooming does not affect relative sizes. The size of a map unit is very different depending on 
whether you are using a degree based CRS or a metre based CRS. The Derby map uses degrees.

It was intended to use the same style for both the tube map and the real map although as 
development proceeded, some slight differences arose.

Routes
Finding good formatting options took a lot of time!



On the real map, each route is named by the main road used for the link. This name is displayed 
within the link. It was found that implementing this for all the links on the tube map made it too 
busy so, currently, just a few links are named on the map making use of Rule based labelling and 
the data field of “show_name”.

The colour scheme for the 5 gradings of routes is from http://colorbrewer2.org/?
type=diverging&scheme=RdYlBu&n=5 The yellow colour was too pale so the colours selected 
were:

#d7191c (red)

#fdae61

#fbfb1f as original is too pale

#abd9e9

#2c7bb6 (blue)

The paler coloured routes are harder to see and adding a black outer line makes their presence 
clearer.

River
The colour of the river is close to the colour of the blue (good) routes. Experimentation suggested 
a paler colour of blue for the river plus a black outline (create a style of 2 x simple lines, one blue 
one and one black one slightly wider. Make sure the blue is on top).

Adding a name for the river makes it clearer what it is. Use Properties>Label

Stations
The Railway station and hospital symbols were created from SVG logos downloaded from the 
internet. Use the SVG logo option within the layer properties.

The names of some stations were better formatted with the name on more than one line. The % 
symbol was used to specify where the text should be wrapped.

The London tube map uses a specific font for its names. The closest that could be easily found 
within QGIS was the Free Sans font.

Creating final tube map

Print composer

Legend
Defining the right legend is essential to understanding of the map. The legend needs to be 
intelligible to the target audience for the map. As the target for the Derby map is the general 
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public, a more subjective (good to bad) rating was used rather than an objective rating based on 
speed limits, traffic volume, etc. which is used successfully on tube maps for other cities.

Creating online map
The free QGIS Cloud service is used to make the map available over the internet. You need to 
register to get a free QGIS Cloud account and then upload the data and the QGIS project to the 
cloud server. 

Acknowledgements
The idea for the map and a lot of the formatting is based on work by Cycle Bath. Cycling UK 
provided encouragement and some training to allow work on the map to start.

The routing makes use of Cyclestreets.

Background mapping using OpenStreetmap

QGIS Cloud is used for online hosting of the “real” map

All development effort has been provided on a voluntary basis and no effort has been funded from 
any source.

Issues
The location of places isn’t exact and this can be an issue for large destinations such as a hospital 
or large employer who often have many entrances to the site, particularly for staff. Deciding which 
one to mark as the location on the map needs thought. It might be necessary to mark more than 
one?

Deciding on the boundaries of the map needs thought. It is easy to get carried away and keep 
adding more and more locations until the map becomes unwieldy. For the Derby map, we 
considered some key towns, villages within the Derby travel to work area (where it might be 
reasonable to expect people to commute from). However, this isn’t complete (some smaller 
location were omitted).

Junctions are not rated by their suitability for cycling. A route from A to B via C may be fine on the 
individual A to C and C to A sections (blue on the map) but the actual junction C may be a 
nightmare for cycling so that the overall A to B journey should perhaps be rated as Red. At the 
moment the junction is excluded but colour coding of the junctions could reflect the rating given to
each junction in a future version.

Access to Files
R code and QGIS style files are provided at https://derbycyclinggroup.org.uk/blog/materials-for-
recreating-tube-map/ for others to make use of together with the latest version of this document. 
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Others are free to make use of the materials subject to providing attribution to the original authors
and not using the material for commercial purposes.

The zip file contains all material necessary for recreating the example Belper map. The QGIS 
project files should provide background information on data formats for your own project. The 
style files can be used to create maps in the same style as the Derby map.

Also provided are R programs to help with the development of the map. These will need to be 
reviewed for your situation and the filenames, etc. modified to match your configuration. 
Understand what the programs are doing before running them! Take regular backups of important 
data!

Existing Cycling Tube maps
Various UK cycle campaigns have created tube maps for various purposes. The maps found include:

• Bath - https://cyclebath.org.uk/map/

• Bristol - https://bristolcycling.org.uk/top-tube-launched/ which has a “real” map backing 

up the schematic map.

• Chesterfield - http://www.chesterfieldcc.org.uk/sites/default/files/image/Underground
%20map/ugmap.jpg

• London - https://londoncyclenetwork.wordpress.com/2016/06/02/london-cycle-lane-
network/

• Edinburgh - http://www.innertubemap.com/

• Birmingham - http://www.toptubemap.com/

• Swansea - http://www.cycleswanseabay.org.uk/ 

Example procedure
As an example, a simple tube map for Belper (a town in Derbyshire) is created.

Create a new project in QGIS

Set project CRS to WGS84

Create a new vector layer – points – named belper_stations

Add OpenCycleMap layer

Add points to the belper_stations layer using the “Add feature” icon.

Apply the stations_style file to the belper_stations layer.
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Run tube_map_routes.R after modifying the file names and layer names at top of program.

This creates shape files for balanced and fastest routes.

Within QGIS add fastest routes as a new vector layer. Apply a suitable style to see routes. 1mm 
wide lines in orange works well.



It is clear that there are some key junctions in the network that haven’t been labelled so add more 
stations e.g.:

• Talbot

• Blackbrook

• Cemetery

• Queens Head

• Kilburn Crossroads

Move some stations (using the node tool) to nearby part of network. Need to retain meaningful 
name for the location moved to. For example, most people would understand that the road by the 
school can be given the school name and the location doesn’t have to be exactly on top of the 
building.

• St Johns

• Belper school

• Morrisons

• River Gardens

• Bus station

• Duffield

• Holbrook



Rerun  tube_map_routes.R to regenerate the routes for the moved and added stations (does all 
routes again). Note that this overwrites the previous versions of the routes so save them 
beforehand if you want to keep them.

Reopen QGIS project. Modified routes files should be reflected in the display. Also add balanced 
routes to explore where different routes have been taken.



Some of the stations and the links from those stations are now clear and a new layer can be 
created which consists of the links (call it belper_routes). As station placement and links are 
decided, change the “Fixed” field for the station to 1 (from 0). This means that the station won’t be
included in the all-to-all routing in future. Over a number of iterations, all stations will become 
fixed.

Create belper_routes as a vector line layer. Add fields to store data.

Turn on snapping to line up routes with the stations. Settings>Snapping options> Advanced. Then 
just select the stations layer and set snapping for 30 pixels. 

When adding a link. Select add feature, then click on beginning and end stations, then right click. 
You are prompted to enter the data. Add a name for the route (main road used), a rating (1-5) and 
a unique ID (number). The From and To fields will be added automatically later.

Dealing with the stations around the edge of the map first seems easiest approach. You’ll find that 
certain junctions are key to the network and you’ll need to add extra stations (with meaningful 
names) for these junctions.



Once some links have been created, rerunning tube_map_routes.R also creates fast, quiet and 
balanced routes between the fixed stations which can be displayed by adding the fastest_route (or 
quietest or balanced)  shapefiles as a new vector layer.

This shows the defined links plus the purple fastest on road routes matching the defined links. 
With some of the orange routes still shown around Duffield it is clear that a station that should 
have been marked as fixed hasn’t been (Duffield).

This is a good time to double-check with all the people providing input that they are happy with 
the number of stations and the routes between stations. Changing the ratings of the routes later is 
relatively easy, adding new stations or moving them significantly means more effort.

Also consider any names that are long and would look better with the text wrapped. Add a % for 
where the text should wrap.



This is now the final version of the “real” map. Once all feedback is collected and implemented – 
move onto “tubyifing” the map.

Add the From and To information to the real map data. Run add_from_to.R This creates a 
new_routes set of shapefiles which should replace the belper_routes (once backup is taken). Also 
creates a route_listing.csv to allow list of routes to be checked. The program also updates the route
ids so they are unique.

Create copies of the belper_routes and belper_stations that will be used for the tube map (name 
as tm_belper_routes and tm_belper_stations). Create a new QGIS project.

Apply the tm_ style files to the routes and stations.

Create a grid – Processing>Commander – search for create grid. Save to file and add to the map.

Select Options>Snapping Options > Advanced and set snapping to the grid (vertex only) – 20 pixels.



Move the stations to positions on the grid. For Belper, the north south line was placed first and 
then a west / east line with other stations placed around them. No need to move the links 
(although this can be done for ease of visibility).

Run update_tube_links.R. This reads all the connections from the real map and creates links 
between the corresponding stations on the tube map. After taking backups, the 
new_tm_belper_routes can be overwritten on the tm_belper_routes and the tube map reopened 
in QGIS. Repeat this process until all the stations are positioned as required.



Final step for the tube map is to put “kinks” into the links so that each angle is either 90 or 45 
degrees. Use node tool to create extra vertexes in the line and then move the new vertex to a grid 
corner.

Turn off display of the grid.



Add the river to give some geographic context. Create a new vector line layer with a field of 
“name”. Turn off the snapping options then add a feature. Draw the line using the grid to see 
where it should best go. Apply the river style file.

Create the online version of the map (the “real” locations). Install the QGIS QGISCloud plugin. 
Create an account with QGISCloud (free although you can get a Pro version for a cost). 
http://qgiscloud.com/

For some reason that I haven’t got to the bottom of, the CRS used in the project causes problems 
with the online map. I think this is related to the CRS used by OpenCyclemap (3857) uses metres 
whereas the project CRS uses degrees. As a workaround, I have:

Opened the “real” tube map project. Saved the routes and stations layers to a different folder with 
the CRS of 3857.

Save project as a new project called Belper_tube_map_cloud_base. Change the data for the 
stations and routes to use the _3857 versions of the data. Ensure the layer CRS and the project CRS
are 3857.

Delete the fastest and balanced layers as these were only used when positioning the stations 
originally.

Logon to QGISCloud and update the tables. You will be asked to save the project as the data 
sources have changed to the online versions. Save as Belper_tube_map_cloud.

Add background layer of OpenCyclemap

http://qgiscloud.com/


Publish map. Should now be publicly available at a location like 
http://qgiscloud.com/smoky/Belper_tube_map_cloud (with your username instead of smoky).

[The above workaround feels overly complicated and there is probably a much better way of 
getting the CRS settings working correctly.]

To create a printed tube map, open the schematic tube map and then create a new “Print 
Composer”.

Add the map to fill the whole page.

Add legend(s) and modify the legend to just include the useful information (e.g. no grid, no 
fastest_route).

Add title in text box. Add explanatory words (try and use the original words from Cycle Bath).

Add copyright notice

Add your organisation’s logo

Add contact information. Note this can be formatted using simple html.

The map can then output as a PDF or an image. Both are useful as the image is useful as a smaller 
file size for use on websites whereas the PDF file is typically large but detailed.

Decide on a versioning system – either numbers or dates.

The Match_tm_real.R program checks through the real and tube maps to make sure the data 
matches. As changes are made after the tube map has been created (as feedback is received, 
errors are fixed, etc.) it is easy for the data on the two maps to be different. The program produces 
a report that lists all the mismatches which can then be corrected by hand.

Feedback
The procedure, the example materials, and this document have been created by Ian Dent 
(ian.dent@derbycyclinggroup.org.uk) who would appreciate feedback on any errors, suggestions 
for improvements, etc. that people find. 

Please acknowledge the contribution of this document and materials in any maps produced for 
your local area.

Good luck!
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